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Вступ 
 

  

HMI (Human-Machine Interface) – це інтерфейс, що забезпечує взаємодію 

між людиною та машиною.  

НМІ як засоби відображення інформації забезпечують передачу критично 

важливих даних операторам, які приймають рішення, і дозволяють 

контролювати стан виробничих систем у реальному часі. 

Якісно розроблений HMI підвищує безпеку. У промисловості HMI 

дозволяє операторам швидко реагувати на помилки системи чи аварійні ситуації. 

До основних засобів відображення інформації на виробництві належать 

візуальні інтерфейси, такі як дисплеї, екрани, сигнальні панелі та діаграми. 

На багатьох виробництвах активно застосовуються аудіовізуальні засоби, 

такі як сигналізація та оповіщення. Наприклад, звукові сигнали вказують на 

необхідність негайної дії оператора у разі виникнення аварійної ситуації. 

Візуальні засоби, наприклад, світлодіодні індикатори, сигналізують про 

поточний стан обладнання. 

Інтуїтивний інтерфейс зменшує час навчання персоналу та прискорює 

виконання задач. На сучасному виробництві оператори можуть налаштовувати і 

контролювати роботизовані системи за допомогою простого дотику до екрана. 

Інтелектуальні системи можуть автоматично аналізувати дані та надавати 

оператору лише релевантну інформацію, зменшуючи ймовірність помилок. 

Віддалені інтерфейси, доступні через мобільні пристрої або комп’ютери, 

забезпечують контроль за виробничими процесами навіть з віддалених місць. 
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Лабораторна робота №1 з програмування HMI в DOP Soft:  

ІНТЕРАКТИВНА ВІЗУАЛІЗАЦІЯ ДЛЯ УПРАВЛІННЯ 
ТЕХНОЛОГІЧНИМ ПРОЦЕСОМ АБО ОБЛАДНАННЯМ 

 
 
МЕТА РОБОТИ: ознайомлення з HMI панеллю DOP-107DV та програмним 

середовищем DELTA DOPSoft. 

ОБЛАДНАННЯ: HMI панель DOP-107DV, середовище програмування панелей 

оператора DELTA DOPSoft. 

 

Переглянути можливості панелі інструментів програми DOPSoft 

 

 
 

Знайти ті інструменти, які відповідають за розміщення на формі різноманітних 

елементів керування технологічним процесом, або елементів відображення 

технологічного обладнання на формі візуалізації:  

кнопки та перемикачі (тумблери), 

спрощені статичні та анімовані зображення технологічного обладнання,  

стрілкові індикатори, 

стовпчикові індикатори,  

лампові індикатори,  

числові індикатори та поля введення,  

слайдери задавання параметрів, 

графіки зміни параметрів. 

 

Перевірити можливість скористатись бібліотекою технологічних зображень. Їх 

можна розмістити на формі, за допомогою елементів, які мають у властивостях 

вкладку Picture. Наприклад, деякі «кнопки» або елемент «прямокутник». 

 

Використовуючи інструменти з панелі інструментів та бібліотеку 

технологічних зображень спроектувати візуальну форму контролю та 

керування технологічним процесом або комплексом обладнання 

( !! технологічний процес або комплекс обладнання обрати самостійно ) 

( !! всі інтерактивні елементи візуальної форми дозволяється не налаштовувати 

і не програмувати) 

( !! якщо технологічний процес складний, дозволяється розбити візуалізацію на 

кілька екранів ) 
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Лабораторна робота №2 з програмування HMI в DOP Soft: 

АВТОМАТИЗОВАНА СИСТЕМА ІНТЕРАКТИВНОГО УПРАВЛІННЯ 
УСТАВКОЮ ТЕХНОЛОГІЧНОГО ПАРАМЕТРА 

 
 
МЕТА РОБОТИ: Набути навичок розробки візуалізацій для HMI панелі DOP-

107DV в програмному середовищі DELTA DOPSoft. 

ОБЛАДНАННЯ: панель оператора DOP-107DV, середовище програмування 

панелей оператора DELTA DOPSoft. 
 
 

Переглянути можливості панелі інструментів програми DOPSoft 

 

 
 

Знайти ті інструменти, які відповідають за розміщення на формі візуалізації 

різноманітних елементів  

- задавання конкретного значення певного технологічного параметра: поля 

числового введення, 

кнопки збільшити/зменшити; 

- елементів відображення зміни в часі заданого технологічного параметра. 
 

Розробити у середовищі програмування DOPSoft інтерактивну візуалізацію для 

автоматичної системи інтерактивного управління уставкою технологічного 

параметру. 

 

Без прив’язування до конкретного технологічного процесу, використовуючи 

інструменти з панелі інструментів спроектувати візуальну форму: 

 

- екран1  

– задавання в числовому вигляді певного технологічного параметра певного 

технологічного процесу; 

– кнопка переходу на екран2; 

– (за бажанням) індикатор знаходження параметра вище заданого значення 

(яке може задаватись у окремому полі); 

– (за бажанням) індикатор знаходження параметра нижче заданого значення 

(яке може задаватись у окремому полі); 

– (за бажанням) індикатор знаходження значення параметра в певних межах 

(які можуть задаватись у окремих полях). 

     

- екран2 

– графік – історичний тренд про зміну в часі заданого значення 

технологічного параметру; 

– кнопка переходу на екран1. 
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2) Вивчити порядок завантаження програми у панель. 

 

4) Запустити програму DOPSoft та перевірити працездатність розробленої 

програми за допомогою емуляції роботи панелі. 

 

5) За допомогою програми DOPSoft завантажити програму в панель та 

перевірити працездатність розробленої програми безпосередньо на панелі. 

 

6) За потреби здійснити корекцію програми та повторного завантаження її у 

панель. 

 

7) Зробити висновки про виконані завдання. У висновках дати відповіді на 

питання:  

 

- Які можливості програмованих панелі оператора використано при розробці 

системи? 

 

- Які переваги управління за допомогою програмованих сенсорних панелей 

оператора перед пультами управління на базі контактних елементів? 

 
- Які можливо запропонувати удосконалення чи модифікації щодо розробленої 
системи? 
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Лабораторна робота №3 з програмування HMI в CoDeSys: 
АВТОМАТИЗОВАНА СИСТЕМА ВІДДАЛЕНОГО КЕРУВАННЯ 

ПАРАМЕТРАМИ СИГНАЛУ УПРАВЛІННЯ ЧЕРЕЗ МЕРЕЖУ 
INTERNET 

 
 
 
МЕТА РОБОТИ: Набути навичок розробки систем автоматичного управління 

виконавчим механізмом циклічної дії на базі промислових програмованих 

логічних контролерів системи CoDeSys з можливостями віддаленого управління 

роботою системи через WEB-сервер CoDeSys. 

ОБЛАДНАННЯ: емулятор промислового програмованого логічного 

контролеру системи CoDeSys, середовище програмування CoDeSys V2.3 для 

промислових програмованих логічних контролерів. 

 

ЗАВДАННЯ 

 

Технологічна схема об’єкту управління: 

 

4 1 

2 

3 

 
Рис.3.1. Технологічна схема об’єкту управління –  

«керований імпульсний ламповий опромінювач». 

 

Пояснення до рис.3.1.:  

 

1- трубопровід подачі сировини; 2- накопичувальна ємність - позиція оброблення 

сировини; 3- імпульсна лампа-опромінювач, 4- трубопровід відведення сировини 

з позиції оброблення. 

 

Алгоритм роботи автоматичної системи управління промисловим 

керованим імпульсним ламповим опромінювачем: 

 

- механізм виконує циклічну зміну параметра (світловий потік): 

«включено/виключено» у автоматичному режимі з можливістю ручної зміни 

амплітуди, періоду та тривалості імпульсу, значення яких зберігаються у 

змінних; 

- при натисненні кнопки «стоп» зміна сигналу на виході припиняється; 
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- при натисненні кнопки «робота» зміна сигналу на виході відновлюється; 

- ручне введення значень параметрів тривалості імпульсу, періоду 

імпульсу, амплітуди імпульсу відбувається у відповідних інтерактивних полях 

на формі візуалізації, введення не зупиняє роботу системи, введені вручну 

параметри одразу ж впливають на вихідний сигнал; 

- екранна форма візуалізації повинна відображати стан змінних управління у 

вигляді графіків. 

- при виклику в Internet - браузері за відповідною http – адресою можливо 

переглянути сторінки керування роботою системи та корегувати параметри 

віддалено; 

 

ПОРЯДОК ВИКОНАННЯ РОБОТИ 

 

1. Розробити в CoDeSys автоматичну систему дискретного управління на базі 

елементів на мові FBD. 

2. Вивчити порядок завантаження програми у логічний контролер. Використати 

контролер емулятор   

4. Запустити програму та перевірити працездатність розробленої програми за 

допомогою емуляції роботи контролера. 

5.  Запустити програму та перевірити працездатність розробленої програми 

безпосередньо на контролері. 

6. За потреби здійснити корекцію циклу контролера за допомогою програмного 

інструменту «Task Configuration». 

7. За допомогою програмного інструменту «Sampling Trace» записати під час 

роботи програми циклограму основних сигналів, яку відобразити у звіті про 

виконане лабораторне завдання. 

8. Зробити висновки про виконані завдання. У висновках дати відповіді на 

питання:  

- які можливості програмованих логічних контролерів використано при розробці 

системи автоматичного управління; 

- які переваги управління за допомогою програмованих логічних контролерів 

порівняно з системами управління на базі релейно-контактних елементів; 

- які можливо запропонувати удосконалення чи модифікації щодо розробленої 

системи управління. 

 

 

ДОДАТКОВІ ЗАВДАННЯ 

 

1. Використовуючи мережу Інтернет спробувати отримувати віддалений доступ 

до програм управління та візуалізацій, створених і запущених на інших 

комп’ютерах у мережі. 

2. Запропонувати доопрацювання у програмі, що дозволяють уникнути 

неправильного введення даних, при якому виникає виключна ситуація: 
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тривалість імпульсу більша за період імпульсу, через яку програма може увійти 

у неробочий режим. 

 

ВІДОМОСТІ ЩОДО ВИКОНАННЯ 

 

Запуск системи програмування CoDeSys V2.3 

 

 Пуск-> Всі програми-> 3S Software-> CoDeSys V2.3 -> CoDeSysV2.3.exe 

 

Створення нового проекту 

 

Створюємо новий проект командою File -> New.  

 

Налагодження цільової платформи Target Settings 

 

У діалоговому вікні Target Settings, у полі Configuration встановити: 3S 

CoDeSys SP PLCWinNT V2.4 (система виконання – емулятор промислового 

програмованого логічного  контролера з додатковими Web- можливостями).  

 

Головна програма PLC_PRG POU 

 

Наступне вікно New POU визначає тип головного створюваного програмного 

компоненту POU.  полі Name оберемо ім’я: PLC_PRG, а нижче відмітимо мову 

програмування: FBD (Function Block Diagram). PLC_PRG це особливий 

програмний компонент (POU - Program Organization Unit). У проектах однієї 

задачі він циклічно викликається системою виконання. 

Обов’язково виконаємо збереження файлів проекту: File -> Save As -> 

(наприклад на Робочий стіл зберігаємо у нову папку Project_01, ім’я проекту 

можна також вибрати як Project_01). 

Також виконаємо налагодження головних папок проекту. У головному меню 

CoDeSys: Project -> Options… -> Directories -> у секції Project -> у полях 

Libraries, Compile Files, Configuration Files, Visualization Files за допомогою 

кнопки  виставити шлях до папки створеного проекту. Типово папка на 

робочому столі користувача має шлях:  

    c:\users\user_name\desktop\project_01 

 

Цей шлях також ввести до поля Compile Files у секції General розділу 

Directories. 

 

Створюємо генератор циклічної дії 

 

Заходимо на вкладку Програмні елементи:   та обираємо 

подвійним кліком PLC_PRG для редагування. 
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У першому ланцюгу графічного FBD редактору з’явився рядок ???. Конкретну 

змінну введемо пізніше.  

Далі виконаємо підключення першого FBD блоку. Виділяємо рядок ???, 

натискаємо на клавіатурі кнопку → , і у квадратику, що з’явився (  ) через 

випадаюче меню викликаємо команду Box (або на панелі інструментів 

натискаємо інструмент ). З’являється блок AND.  

Але навіщо нам AND? Тому AND замінюємо на TON (блок затримки 

включення) та натискаємо Enter. Цей блок формуватиме затримку на 

формування кожного наступного імпульсу генератора. Назвемо блок timer_1, 

замінивши символи ???, що розташовані над блоком. Після натиснення Enter 

з’являється вікно Declare Variable (помічник декларування нових змінних). 

Назва блоку буде оголошена як змінна певного типу - за типом блоку. 

 

 
 

 Якщо нічого не змінювати, то змінна (timer_1 типу TON) буде локальною 

(VAR) змінною у програмі і відображатиметься у верхній частині вікна 

редактора програми FBD: 

 
 

Викликаємо випадаюче меню у квадратику біля виходу Q блоку timer_1 і 

обираємо команду Box. Так ми додамо до виходу блоку timer_1 наступний блок 

TOF (блок затримки виключення). Цей блок буде формуватиме затримку, що 

визначатиме тривалість кожного імпульсу. Назвемо його timer_2. Таким чином 

отримаємо ланцюг з двох блоків. Для того, щоб генератор працював постійно, 

необхідно призначити його вихід певній змінній зациклити його вхід та вихід, а 

також налагодити часові інтервали для блоків  TON та TOF. 
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Виділимо вихід блоку timer_2 (вихід генератора) і через випадаюче меню 

оберемо Assign – присвоїти (або інструмент  панелі інструментів ). 

Далі ввести замість ??? назву вихідної змінної, наприклад, gen_out. У вікні 

Declare Variable призначити їй тип BOOL – булева (логічна) змінна, та клас 

VAR – локальна змінна. 

Зациклюємо генератор призначивши йому на вхід ту ж змінну gen_out (просто 

ввести замість ??? на вході IN блоку timer_1 ім’я змінної: gen_out).  

Задамо параметри часової 2-секундної затримки на входах РТ обох блоків: 

замінимо ??? на параметри часових інтервалів «t#2s» (у форматі часу CoDeSys – 

підсвічування рожевим після введення означає, що значення введено за 

правильним форматом). Тоді стани включено та виключено на виході 

генератора триватимуть по 4 секунди. 

 
 

Запустимо програму з генератором: 

1) Включення режиму симуляції:  

 Головне меню -> Online -> Simulation Mode; 

2) Підключення до контролеру:  

 Головне меню -> Online -> Login  

 (або інструмент  панелі інструментів); 

3) Запуск програми: Головне меню -> Online -> Run  

(або інструмент   панелі інструментів). 

  

Якщо ваш генератор запрацював, декілька абзаців нижче можна пропустити. 

 Якщо все виконано вірно, то генератор вийде непрацездатний. 

 

Розширюємо форми візуалізації 

інтерактивними елементами 

 

Для керування генератором необхідні додаткові елементи на форми 

візуалізації:  

- кнопка пуску генератора,  

- кнопка зупинки генератора,  

- поле вводу тривалості імпульсів, 

- поле вводу періоду імпульсів, 

- поля-шильдики з підписами величин, що вводитимуться оператором у поля 

вводу. 

 

Зв'язуємо елементи форми  

візуалізації з програмою 

Запуск системи виконання – емулятора контролера 

Налагодження каналу з’єднання з контролером 
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Завантаження програми у контролер - систему виконання 

Запуск проекту 

 

ДОДАТКОВІ ЗАВДАННЯ  

ДЛЯ САМОСТІЙНОЇ РОБОТИ 

 

1. Пояснити принцип роботи створеної системи управління.  

2. Пояснити які функціональні можливості програмованого  логічного 

контролера OWEN PLC 100 обмежені? 

3. Пояснити через які функціональні можливості систему виконання програми 

програмованого логічного контролера  3S CoDeSys SP PLCWinNT V2.4 

прийнято в якості базису для системи управління з візуалізацією через Internet 

browser? 

4. Які FBD блоки застосовано у розробленій системі управління? 
5. Пояснити порядок налагодження Web-сервера. 
 
 
  



Житомирська 

політехніка 

МІНІСТЕРСТВО ОСВІТИ І НАУКИ УКРАЇНИ 

ДЕРЖАВНИЙ УНІВЕРСИТЕТ «ЖИТОМИРСЬКА ПОЛІТЕХНІКА» 

Система управління якістю відповідає ДСТУ ISO 9001:2015 

Ф-20.10-

05.02/2/174.00.1/М/ОК10-

1-2024 

Випуск 1 Зміни 0 Екземпляр № 1 Арк  58  / 13 

 

Лабораторна робота №4 з програмування HMI в CoDeSys: 
АВТОМАТИЗОВАНА СИСТЕМА УПРАВЛІННЯ ПРОМИСЛОВИМ 

ЦИКЛІЧНИМ МЕХАНІЗМОМ (Ч.1) 
 
 
МЕТА РОБОТИ: Набути навичок розробки систем автоматичного управління 
виконавчим механізмом циклічної дії на базі промислових програмованих 
логічних контролерів PLC. 
 
ОБЛАДНАННЯ: середовище програмування CoDeSys V2.3 для промислових 
програмованих логічних контролерів, CoDeSys сумісний промисловий 
програмований логічний контролер. 
 
ЗАВДАННЯ 
 
Технологічна схема об’єкта управління: 
 
 

 
Рис. 4.1. Технологічна схема об’єкту управління –  

«промисловий механізм циклічної дії». 
 
Алгоритм роботи автоматичної системи управління промисловим 
механізмом циклічної дії: 
 
- механізм виконує циклічний рух в площині по позиціям – вершинам квадрату 
А,  Б, В, Г, А … у автоматичному режимі; 
- тільки при натисненні кнопки «дозволити» розблоковується керування 
кнопкою «рух» та включається індикатор «дозволити» про дозвіл на запуск 
системи; 
- якщо натиснута кнопка «заборонити», кнопка «рух» блокується, індикатор 
дозволу вимикається, механізм зупиняється, якщо до цього здійснював рух; 
- після натиснення кнопки «рух» механізм починає рух; 
- через 10с вмикається сигналізація «підтвердити»; 
- ще через 5с, якщо кнопку «рух» не натиснуто, рух механізму припиняється, в 
іншому випадку сигналізація «підтвердити» вимикається, а рух продовжується 
без зупинки; 
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- якщо механізм нерухомий вмикається сигналізація «зупинка». 
 
ПОРЯДОК ВИКОНАННЯ РОБОТИ 
 
1. Вивчити порядок програмування логічного контролеру.  
2. Розробити автоматичну систему дискретного управління на базі стандартних 
FBD елементів та блоків CFC.  
3. Запустити програму та перевірити працездатність розробленої програми за 
допомогою емуляції роботи контролера. 
4. Запустити програму та перевірити працездатність розробленої програми 
безпосередньо на контролері. 
5. За потреби здійснити корекцію циклу контролера за допомогою програмного 
інструменту «Task Configuration». 
6. За допомогою програмного інструменту «Sampling Trace» записати під час 
роботи програми циклограму основних сигналів, яку відобразити у звіті про 
виконане лабораторне завдання. 
7. Зробити висновки про виконані завдання. У висновках дати відповіді на 
питання:  
- які можливості програмованих логічних контролерів використано при 
розробці системи автоматичного управління; 
- які переваги управління за допомогою програмованих логічних контролерів 
порівняно з системами управління на базі релейно-контактних елементів; 
- які можливо запропонувати удосконалення чи модифікації щодо розробленої 
системи управління. 
 
ДОДАТКОВІ ЗАВДАННЯ 
 
1. Використавши заготовки графічних файлів із зображеннями елементів 
механізму, покращити вигляд візуалізації, забезпечивши анімацію із зовнішнім 
виглядом механізму. 
 
 

ВІДОМОСТІ ЩОДО ВИКОНАННЯ 
 
Порядок програмування CoDeSys сумісних логічних контролерів. 
 
 
 
Створення нового проекту в CoDeSys 
 
Знаходимо у меню пуск пункт 3S Software із встановленими компонентами 
CoDeSys: 
 

  
 
Відкривши пункт  3S Software, обираємо і  запускаємо програмне середовище 
CoDeSysV2.3 для програмування PLC: 
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Створюємо новий проект командою File -> New.  
 
 
Налаштування цільової платформи Target Settings 
 
На сторінці діалогового вікна Target Settings (цільова платформа – тобто PLC, 
для якого програмуємо) у полі Configuration встановити симулятор  
 

 
 
 
Головна програма PLC_PRG POU 
 
Наступне вікно визначає тип головного створюваного програмного компоненту 
POU. Оберемо мову програмування FBD (Function Block Diagram). та ім’я 
Name PLC_PRG. PLC_PRG це особливий програмний компонент (POU). У 
проектах однієї задачі він циклічно викликається системою виконання. 
 

 
 
 
Оголошуємо Перемикач підтвердження 
 
Це змінна яка буде змінювати значення при підтвердженні коректності роботи 
механізму оператором. 
У першому ланцюгу графічного FBD редактору виділіть рядок ???  
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та введіть найменування нашої першої змінної. Нехай це буде Observer 
(спостерігач). Тепер натисніть на клавіатурі →. У новому діалозі визначення 
змінної збережіть найменування (Name Observer) та логічний тип (Type 
BOOL). Змініть клас змінної (Class) на глобальний (VAR_GLOBAL). 
Підтвердіть визначення – ОК. Тепер визначення змінної Observer повинно 
з’явитися у вікні глобальних змінних проекту (Global-Variables): 
 
VAR_GLOBAL 
Observer: BOOL; 
END_VAR 
 
 
Це вікно можливо знайти, якщо зайти на 
вкладку Resources, і увійти у підпункт 
Global_Variables: 
 
 
Повертаємося у редактор програм для 
контролера: переходимо у вкладку 
POUs і виконуємо подвійний клік на 
компоненті PLC_PRG(PRG): 
 

 
 
 
 
 
 
 
Детектор переднього (наростаючого R – rise) фронту 
 
Оператор повинен підтвердити роботу саме перемикачем кнопки, а не просто 
спати з постійно натиснутою кнопкою підтвердження. Щоб розрізнити ці 
ситуації необхідно визначити моменти натиснення та відпускання, тобто 
переходи значення логічної змінної з нуля (FALSE) у одиницю (TRUE) і 
навпаки. 
 Поверніться у вікно редактору PLC_PRG та виділіть позицію справа від 
змінної Observer.  Ви побачити маленький пунктирний прямокутник. Клікніть 
по ньому правою клавішею мишки. У контекстному меню вводу задайте 
команду Box. 
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За замовчуванням, вставляється елемент AND. Скористаємося асистентом 
вводу: натисніть клавішу F2. У діалоговому вікні (зліва) виберіть категорію: 
стандартні функціональні блоки (Standart Function Blocks). З тригерів (trigger) 
стандартної бібліотеки (standart.lib) оберіть R_TRIG. R_TRIG формує логічну 
одиницю по передньому фронту на вході.  
Необхідно задати ім’я для нового екземпляру функціонального блоку R_TRIG. 
Клікніть мишкою над зображенням тригеру та введіть ім’я Trig1. У діалозі 
визначення змінних необхідно вказати клас Class VAR (локальні змінні), ім’я 
(Name) Trig1 та тип (Type R_TRIG). Натисніть ОК. 
 
Детектор заднього (спадаючого F-fall ) фронту 
  
Виділіть вихід функціонального блоку Trig1 та вставте (як було описано вище) 
елемент AND та перейменуйте його у OR (логічне АБО). Виділіть вільний вхід 
функціонального блоку OR та вставте перед ним екземпляр функціонального 
блоку F_TRIG під іменем Trig2. На вхід F_TRIG, за допомогою асистента 
вводу (F2) подайте (категорія Global Variables) змінну Observer. 
 
 
Контроль часу, частина перша 
 
 Вставте після OR екземпляр функціонального блоку TOF (таймер із 
затримкою виключення) під іменем Timer1. Замініть три знаки питання на 
вході РТ константою T#10s. Вона відповідає 10 секундам. Цей час можна 
змінювати у процесі відладки. 
 
 
Вихід Попередження 
 
 Виділіть вихід Q таймеру Timer1 і у контекстному меню (права кнопка 
мишки) дайте команду Assign (присвоїти). Замініть питання на ім’я змінної 
Warning. У діалозі визначення задайте клас Class VAR_GLOBAL та тип 
BOOL.  
 Тепер виділіть позицію у середині лінії, що з’єднує вихід таймера та 
змінну Warning. Задайте команду Negate у контекстному меню. Маленьке коло 
означає інверсію значення логічного сигналу. 
 

 
 
 
Формуємо Стоп Сигнал по другому інтервалу часу 
 
Вставляємо POU управління механізмом 
 
Визначаємо послідовність роботи механізму 
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 Кожній фазі роботи повинен відповідати визначений етап (крок). Виділіть 
перехід (Trans0) так, щоб його обітнула пунктирна рамка.  
 

Клікніть правою кнопкою мишки на перехід і викличте випадаюче 
контекстне меню. У контекстному меню дайте команду вставки кроку і 
переходу: Step-Transition (after).  
 
Аналогічно виділяємо останній перехід і повторюємо вставку кроку ще 4 рази. 
Враховуючи Init, повинно вийти 6 кроків з переходами. 
 
 Клікаючи мишкою по іменам (тексту) переходів і кроків, ви помітите, що 
вони виділяються кольором. Таким чином ви можете визначити нові 
найменування. 
 Перший після Init крок повинен називатися Go_Right. Під ним Go_Down, 
Go_Left, Go_Up, та Count. 
 
 
Програмуємо перший крок 
 
 Клікніть подвійно на кроці Go_Right. CoDeSys почне визначення дії кроку 
і запитає обрати мову його реалізації (Language). Оберіть мову ST (Structure 
Text). У цьому кроці робочий орган нашого механізму повинен переміститись по 
осі X вправо. Програма повинна виглядати так: 
 
X_pos := X_pos + 1 ; 
 
!! зверніть увагу :=  є знаком присвоєння. 
!! команди завершуються знаком ; 
Завершіть введення кнопкою Enter і визначте змінну X_pos як INT (ціле). 
Тепер верхній кутик кроку повинен бути зафарбований. Це ознака того, що дія 
цього кроку визначена. 
 
 
Програмуємо наступні кроки 
 
Визначаємо переходи 
 
 Перехід повинен містити умову, що дозволяє переключення на наступний 
крок. Перехід після кроку Init назвіть  Start і визначте це слово як нову логічну 
змінну (Class = VAR_GLOBAL, тип Type = BOOL). При одиничному значенні 
цієї змінної починається цикл роботи механізму. 
  
Зупинка механізму 
 
Поверніться до  PLC_PRG(PRG) та додайте третій ланцюг. 
    На заміну ??? вставте змінну Stop, і потім з контекстного меню вставте 
оператор Return. Return припиняє роботу програми PLC_PRG(PRG) при 
одиничному значенні Stop. 
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Виклик програми управління механізмом Machine POU 
 
 Додайте ще один ланцюг, виділіть його і вставте елемент Box з 
контекстного меню. Як і має бути, це буде елемент «AND». Натисніть <F2> і у 
асистенті вводу задайте machine POU, обравши його з категорії користувацьких 
програм (User defined Program category). 
 
 
Компіляція проекту 
 
 Відкомпілюйте проект в цілому командою меню Project->Rebuild all, або 
клавішею <F11>. Якщо ви зробили все вірно, то у нижній частині вікна повинне 
з’явитись сповіщення «0 errors». Інакше необхідно виправити допущені 
помилки. У цьому допоможуть розгорнуті сповіщення про помилки. 
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Лабораторна робота №5 з програмування HMI в CoDeSys: 
АВТОМАТИЗОВАНА СИСТЕМА УПРАВЛІННЯ ПРОМИСЛОВИМ 

ЦИКЛІЧНИМ МЕХАНІЗМОМ (Ч.2) 
 
 
ВІДОМОСТІ ЩОДО ВИКОНАННЯ 
 
Порядок створення візуалізацій для програм CoDeSys сумісних логічних 
контролерів. 
 
 
Створюємо візуалізацію 
 
 Третя вкладка організатора об’єктів CoDeSys називається візуалізація 
(Visualization).  
 
 

 
 
 
Перейдіть на вкладку візуалізації.  
 
У контекстному меню введіть команду додавання об’єкту Add object. Надайте 
новому об’єкту ім’я Observation. 
 
 
Рисуємо елемент візуалізації 
 
 Почнемо з перемикача підтвердження - прямокутник з текстом «ОК». На 
панелі інструментів оберемо прямокутник (Rectangle). У вікні редактора 
візуалізації натисніть ліву кнопку мишки і розтягніть прямокутник до потрібної 
висоти та ширини, відпустіть клавішу. 
 
 
Налагодження першого елементу візуалізації 
 
 Діалогове вікно налагодження елемента викликається подвійним кліком 
мишки на його зображенні. Задайте у вікні вмісту (Contents) категорії текст 
(Text Category) слово «ОК».  
Тепер перейдіть у категорію змінних (Variables Category), клікніть мишкою у 
полі зміни кольору (Change Color) і використайте асистент  вводу <F2>. 
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Вставте змінну .Observer зі списку глобальних змінних. Далі перейдіть у 
категорію кольору (Colors). Задайте колір заповнення елементу (Inside), 
наприклад, світло-блакитний. Для стану активації (Alarm color), заповнення 
(Inside), задайте, наприклад, блакитний. У категорії вводу (Input Category) 
необхідно ще раз ввести змінну Observer та поставити прапорець Toggle 
variable. Закрийте діалог налагодження. 
Як результат, прямокутник буде відображатись світло-блакитним при значенні 
змінної Observer рівному FALSE та блакитним, при значенні TRUE. ЇЇ 
значення буде змінюватись при кожному натисненні прямокутника мишкою. 
 
 
Розвиваємо візуалізацію 
 
 Нарисуйте коло для індикатора «Увага» («Warning»).  
У настройках, Text Category -- Contents задайте текст «Увага». Colors 
Category -- Colors заповнення Inside сірим кольором, Alarm color червоним 
кольором.  
 
Скопіюйте створене коло командою Edit -> Copy та вставте її один раз 
командою Edit -> Paste. Підправте настройки нового кола «Зупинка» («Stop»): 
 Text Category -- Contents - текст Зупинка 
Variable Category -- Color change - змінна .Stop 
 
Нарисуйте прямокутник для кнопки «Пуск» («Start»), з такими параметрами: 
Text Category, Contents - текст Start 
Variable Category, Color change - змінна .Start 
Input Category, прапорець Toggle variable 
Input Category, біля Toggle variable - змінна .Start 
Colors Category, Color, Inside - колір червоний 
а Alarm color - колір зелений. 
 
Нарисуйте прямокутник для лічильника кількості циклів механізму з такими 
настройками: 
Text Category -- Contents - текст Counter : %s  
            
 (або Лічильник : %s) 
(%s заміщувач для відображення значення змінної) 
Variable Category -- Textdisplay - змінна Machine.Counter 
 
Нарисуйте невеликий прямокутник (або коло), що позначає робочий інструмент 
механізму. Подвійно клікнувши на ньому, викличемо вікно його властивостей. 
В ньому зліва у переліку груп властивостей оберемо Absolute movement: в цій 
категорії задамо X-Offset = Machine.X_pos,  
а Y-Offset = Machine.Y_pos. Також клікнемо по групі властивостей Colors: де 
Color, Inside - колір блакитний. 
 
 За бажанням, нарисуйте дві декоративних рамки для розділення областей 
контролю та механізму. Задайте у них відповідні написи з вирівнюванням по 
низу (Vertical alignment = bottom). Використовуючи контекстне меню, можна 
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розмістити декоративні прямокутники на задньому плані (команда Send to 
back).  
 
 
Запуск симуляції роботи програми на PLC 
 
Заміна елементів відображення,  
що на візуалізації, на реалістичні  
візуальні об’єкти 
 
 За бажанням можна доповнити рисунок нерухомою плитою для 
розміщення заготовок plate_1_11.bmp. На задній план рисунок можна 
перемістити, клікнувши по ньому правою кнопкою мишки, і, обравши з 
випадаючого меню команду Send to back. Загалом, можна отримати такий 
вигляд візуальної форми: 
 

 
 
Запустимо програму в режимі симуляції (встановлений прапорець у меню 
Online -> Simulation) Умовне з’єднання з контролером встановлюється 
командою Online -> Login. Команда Online -> Run запускає проект на 
виконання. Перейдіть у вікно візуалізації та перевірте роботу кнопок та 
механізму. 
 

Таблиця станів  
(1- активний стан/активовано вручну,  

0-неактивний стан, рухи робочого органу: ↑ → ↓ ←, st - зупинка робочого 
органу, 0..5 – покази лічильника) 

 
Час, 
секунди 

Кнопка 
Пуск 
(Start) 

Кнопка 
ОК 

Індикатори Лічильник 
(Counter) 

Портал Робочий 
орган Увага 

(Warning) 
Зупинка 
(Stop) 
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Запуск проекту  
 
 З’єднання з контролером встановлюється командою Online -> Login. 
Команда Online -> Run запускає проект на виконання. Перейдіть у вікно 
візуалізації та перевірте роботу механізму. 
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Лабораторна робота №6 з програмування HMI в SCADA Movicon: 
ОЗНАЙОМЛЕННЯ З БАЗОВИМИ МОЖЛИВОСТЯМИ SCADA/HMI 

СИСТЕМИ MOVICON 
 
 
 
 
МЕТА РОБОТИ: Набути навичок у використанні основних можливостей 

платформи SCADA/HMI Movicon.  

ОБЛАДНАННЯ: середовище програмування SCADA/ HMI систем Movicon 

v.11.2. 

 

ЗАВДАННЯ 

 

Алгоритм роботи системи: 

 

- система виконує функції людино-машинного інтерфейсу у розподілених 

системах автоматизованого управління, функції системи безперервної 

реєстрації, функції системи зв’язку із зовнішніми пристроями 

введення/виведення, пристроями програмованої логіки; 

- візуалізація містить елементи кнопкового управління, елементи слайдери для 

безперервного та плавного задання значень технологічних параметрів, 

елементи виразного відображення технологічного обладнання, елементи 

динамічної анімації зміни значень технологічних парметрів; 

- візуалізація також містить таблицю реєстрації даних про аварійні сповіщення, 

активовані за час роботи системи автоматики.  

 

 

ПОРЯДОК ВИКОНАННЯ РОБОТИ 

 

1. Розробити візуальні форми з елементами відображення основних 

технологічних параметрів, полів вводу та елементів кнопкового управління, 

слайдерами неперервного задання параметрів та засобами інтерактивного 

відображення сповіщень. 

2. Забезпечити у програмі наявність каналів з’єднань з зовнішніми пристроями 

автоматики. 

3. Запустити програму та перевірити її працездатність. 

4. Зробити висновки про виконані завдання. У висновках дати відповіді на 

питання:  

- які можливості SCADA систем використано при розробці візуальних форм 

людино-машинної взаємодії; 

- які переваги створеної системи; 

- які можливі обмеження має використана технологія, 

- які можливо запропонувати удосконалення чи модифікації щодо виконаної 

розробки. 
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ДОДАТКОВІ ЗАВДАННЯ 

 

1. Передбачити у системі на візуалізації елементи управління, що дозволяють 

переключатись між екранними-формами. 

2. Створити декілька алармів дискретної дії (наприклад реагуючих на 

натиснення кнопок). 

3. Забезпечити декілька інтерактивних візуальних елементів – індикаторів, що 

працюють для відображення стану алармів. 

 

 

ВІДОМОСТІ ЩОДО ВИКОНАННЯ 

 

Запуск програмного середовища Моvicon  

у режимі програмування (розробки) 

 

 Пуск-> Всі програми-> Movicon 11.2->  

  -> Movicon 11.2.exe 

 

Створення нового проекту 

 

Якщо середовище Movicon вже хоча б раз запускалося, то при відкритті буде 

відкрито попередній проект:  

 

 
 

Закриємо його: 

Клікнемо правою кнопкою мишки на кореневий елемент дерева проекту, як 

показано на рисунку, і у випадаючому меню оберемо команду Закрити. 

Тепер створення нового проекту потрібно розпочати командою Файл -> Новий 

(або інструментом  з панелі інструментів), одразу ж буде відкрито вікно 

майстра створення нового проекту, як на рисунку нижче. 

Якщо середовище Movicon запускається вперше то продовження запуску також 

супроводжується вікном майстра створення нового проекту: 
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 Далі оберемо тип платформу, на якій буде виконуватися створений 

проект: оберемо Win 32 (тобто для виконання на комп’ютері з 32 розрядною 

Windows, наприклад, промисловий комп’ютер з Windows CE 6.0, або на 

звичайному персональному комп’ютері). Вибір платформи впливає на перелік 

можливостей при подальшому наповненні проекту. Проте, обрану платформу 

завжди можна змінити у подальшому. 

  

 
 

Розкривши пункт Екрани у Експлорері Проекту кліком на позначці +, 

побачимо, що вони були створені: 

 

 
 

 

Додавання нового екрану 

 

  У Експлорері Проекту клікнути правою кнопкою мишки на пункт 

Екрани і з випадаючого меню обрати команду Новий екран. З’явиться поле з 

пропозицією змінити назву нового екрану. Введемо, наприклад, My_screen_01. 

Після натиснення ОК, одразу ж з’явиться незаповнена візуальна форма 
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My_screen_01. На правому краї вікна середовища Movicon наведемо вказівник 

мишки на позначку   елементу Властивості.   

 

 
 

При наведенні вказівника мишки плавно розкривається вікно властивостей 

поточного елементу екрану My_screen_01. У переліку властивостей знайдемо 

пункт Фон і розкриємо його, клікнувши на позначку +. Оберемо кремовий 

колір фону: 

 

 
 

 Обраний параметр буде застосовано після вибору і подальшого 

натиснення Enter, або кліку на інструменті V панелі інструментів вікна 

властивостей: 

 
 

 Тепер екран My_screen_01 можна тимчасово закрити, натиснувши Х біля 

назви вкладки і пізніше викликати подвійним кліком з дерева проекту у вікні 

Експлорері Проекту. 

  

 

Виконання графічного редагування екранних форм 

 

 Звернемося знову до Експлорера Проекту та подвійним кліком 

відкриємо знову елемент-екран My_screen_01. 

 Для того, щоб перейти до графічного редагування використаємо графічні 

інструменти, які можна обрати з панелі інструментів Об’єкти, яку можна 

відкрити навівши вказівник мишки на позначку  елементу Об’єкти, яка 

розташована біля правого поля вікна середовища Movicon: 
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 Після появи об’єкту на екранній формі. Можна викликати вікно 

властивостей елемента, просто клікнувши на ньому (виділивши його), і 

приступити до редагування його параметрів. 

 

 

Використання бібліотеки символів 

 

 
 

 

 Виведемо на екран один з об’єктів. Вкладки графічних об’єктів 

розташовані за алфавітом. Знайдемо вкладку Tanks. Розмістимо на екранній 

формі об’єкт Tank_c:  

 

 
 

  

Створення власного графічного символу 

 

 Певна сукупність розміщених на екранній формі графічних об’єктів може 

бути згрупована у один графічний символ. 

 Відкриємо Інструмент об’єкти і використовуючи елементи групи 

Базовий рисунок виконаємо розміщення на екранній формі сукупності 

елементів: 
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 Можна побачити, що у переліку присутні також окремі елементи 

символу. Клікнувши на них ми можемо викликати їх властивості і редагувати 

окремо від об’єкта. 

 

 
 

  

Створення динамічної анімації змін кольору 

 

 Спочатку додамо графічний елемент, який будемо анімувати. Нехай це 

буде графічний елемент труба, який імітуватиме теплообмінник у баку: 

 

 
 

 Подвійно клікнемо на тільки-но доданому трубопроводі. Буде виведено 

вікно властивостей елемента. З вікна властивостей обрати групу Анімації. 

Розкрити групу, клікнувши на +. Обрати позицію Динамічний Текст…. 

Розкрити її, натиснувши +. Поставити галочку  біля позиції Активувати 

Динамічний Текст, а також галочку  біля позиції Поступове 

перемішування кольорів. Далі клікнути у полі  властивості Тег Текст та 

Контур. За допомогою кнопки  та подальшої вкладки Змінні обрати змінну, 

що керуватиме зміною кольорів. Оберемо раніше створену змінну signal_01. 

Далі клікаємо на кнопку  налагодження властивості Редагувати межі 

кольору. Відкриється вікно редагування меж активації кольорів по значенню 

змінної.  
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Прийшов час запустити проект і спробувати анімацію. 

 

Запуск проекту в режим RunTime 

 

 

 
 

 

Створення динамічної анімації зміни положення 

 

 Викличемо вікно Об’єкти і у групі об’єктів Базовий Рисунок оберемо 

графічний об’єкт Мультилінія  та накреслимо на екранній формі імітацію 

вигнутої направляючої біля символу Каретки, створеної нами раніше: 

 

 
  

 

 
  

 
 

 

 
 

Запустимо проект у режим RunTime інструментом  на головній панелі 

інструментів. Переміщуючи слайдер перевіримо працездатність анімації. 

Відключимо режим RunTime кнопкою  в меню вікна виконання візуалізації і 

повернемося до редагування проекту. 
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Використання команд 

 

 Увійдемо до вікна Об’єкти, активувавши вкладку з правої сторони 

робочої області -> оберемо групу об’єктів Кнопки-Світло -> оберемо кнопку 

Зелений квадрат -> клікаємо лівою кнопкою мишки на робочій області 

екранної форми, і, не відпускаючи ліву кнопку мишки,  розтягнемо об’єкт до 

потрібного розміру. Отримуємо об’єкт кнопка.  

 
 

 Подвійно клікаємо на доданому об’єкті і викликаємо вікно його 

властивостей -> обираємо групу параметрів Загальний -> задаємо параметр 

Назва Об’єкта = Т норм (наприклад) -> обираємо групу параметрів 

Виконання -> обираємо параметр Тип команд = Виконати команди -> 

обираємо параметр Команди при Натиснутій Кнопці, і за допомогою 

допоміжної кнопки , викликаємо вікно заповнення Список Команд. 

  

Робота з алармами  

(сигналами аварій) 

   

  

 
 

 
 

Тут можна додати додаткові колонки, що представлятимуть ті ж рядки, але на 

інших мовах. 
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 Аларм – це поняття загальне. Потрібно визначити межі значень сигналу 

для спрацювання аларму. 

 Створимо ще декілька меж: 

 

  Ім’я межі = Т мін 

  Текст Аларму = Рядок 00002 «Зниження парамет-   ру 

до значення 0 !» 

   Звуковий Сигнал 

  Значення Активації = 0 

  Умова Активації = Дорівнює 

  

Візуалізація активних алармів 

 

 Спочатку скопіюємо у Екран Алармів з My_screen_01 перший слайдер, 

який керує змінною signal_01 (так нам зручніше буде перевіряти дію алармів по 

змінам значення змінної signal_01 без переключення з екрану на екран). 

 Далі додамо автоматизоване вікно відображення активних алармів, вже 

спроектоване та пропоноване у середовищі Movicon. 

   

  

 
 

 Режим RunTime автоматично запуститься з відображенням сторінки 

екранної форми, що поточно редагувалась. Проте, якщо потрібно змінити 

сторінку, при відсутності кнопок переходу між сторінками (екранами), можна 

скористатися інструментом , що знаходиться на панелі інструментів режиму 

RunTime: 

 

 
 

 Відключити режим RunTime можливо кнопкою . 
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Лабораторна робота №7 з програмування HMI в SCADA Movicon: 
SCADA ДЛЯ НЕПЕРЕРВНОГО ТЕХНОЛОГІЧНОГО ПРОЦЕСУ НА БАЗІ 

SCADA/HMI MOVICON ТА CODESYS-СУМІСНОГО PLC (Ч.1) 
 

 
 
МЕТА РОБОТИ: Набути навичок у використанні можливостей SCADA/HMI 

Movicon. Навчитись використовувати ОРС сервер для зв’язку PLC та 

SCADA/HMI системи.  

 

ОБЛАДНАННЯ: емулятор CoDeSys сумісного контролеру SP PLC WinNT, 

середовище програмування контролерів CoDeSys V2.3, середовище 

програмування SCADA/ HMI систем Movicon v.11.2. 

 

ЗАВДАННЯ 

 

Функціональна схема системи автоматики: 
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Рис. 6.1.Функціональна схема автоматизованої системи. 

 

Пояснення до рис. 6.1.:  

 

1- джерела сигналів про поточні значення технологічних параметрів від об’єкта 

управління; 3- сигнали на виході PLC для подачі на виконавчі механізми; 2,4- 

вхідний та вихідних порти ППЛК (PLC); 5- цифровий порт ППЛК (PLC); 6- 

цифровий порт ПК (PC); program- програма регулятора завантажена у PLC; 

SCADA visualization- програма візуалізації технологічних даних та елементів 

управління системи автоматичного регулювання; - програмне забезпечення для 

передачі технологічних даних з PLC до елементів візуалізації та від 

візуалізованих елементів управління до PLC. 
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Алгоритм роботи автоматичної системи контролю: 

 

- система складається з джерела технологічних даних – PLC, який керує певним 

технологічним процесом, програмного серверу OPC, та OPC клієнта – 

запущеного у режимі RunTime проекту SCADA системи; 

- PLC під час роботи змінює в часі певні технологічні параметри та передає 

дані про них у символьний файл, що на ПК, через посередництво Gateway 

сервера; 

- задача OPC сервера – зареєструватись у операційній системі та 

транслювати дані про технологічні параметри будь-якому OPC клієнту;  

- додатково задача OPC сервера – пересилати дані про змінені в OPC клієнті 

технологічні параметри через символьний файл в програму, що виконується у 

PLC; 

- OPC клієнт запитує дані про потрібний параметр у OPC сервера і реєструє 

їх власними засобами, а також передає OPC серверу дані про змінені 

технологічні параметри для передачі їх через символьний файл у PLC; 

- OPC клієнт має засіб візуального відображення технологічних параметрів 

у реальному часі, елементи управління зміною технологічних параметрів, 

елементами сигналізації про певні стани технологічних параметрів, систему 

створення звітів по статистичним даним технологічного процесу, інші засоби 

інтерактивної взаємодії з оператором; 

- система дозволяє віддалене управління нею через WEB клієнт; 

- технологічних процесс: сушіння сировини у барабанній сушарці (джерело 

технологічних даних – готова модель технологічного процесу надається 

викладачем та закладається у PLC, або в емулятор PLC); 

- розроблена SCADA/HMI система є OPC клієнтом та має інтерактивні форми 

для взаємозв’язку з оператором технологічного процессу; 

- інтерактивні візуальні форми SCADA/HMI системи це 2 екрани: 

  

o Екран 1 інтерфейсу з оператором містить зображення: 

▪ технологічні ємності: 

• «бункер сировини», 

• «сушильний барабан»,  

• «циклон», 

 

▪ трубопроводи:  

• «подача сировини у бункер сировини», 

• «подача сировини з бункеру у сушильний  

барабан», 

• «подача гарячого повітря в барабан», 

• «витяжка повітря з барабану у до вентилятора», 

• «подача повітря з вентилятора до циклону», 
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• «відвід повітря з циклону у атмосферу», 

• «відвантаження сировини з барабану на конвеєр готової продукції», 

 

▪ кнопки типу:  

• «відкрити/закрити клапан на трубопроводі подачі сировини в бункер 

сировини»,  

• «пуск/зупинка приводу шнеку подачі сировини з бункера у барабан»,  

• «пуск/зупинка приводу сушильного барабану»,  

• «пуск/зупинка приводу вентилятора витяжки гарячого повітря з 

барабану»,  

• «на екран таблиці алармів», 

 

▪ двигуни: 

• «двигун приводу шнеку», 

• «двигун приводу барабана», 

• «двигун вентилятора витяжки», 

 

▪ слайдери: 

• «швидкість подачі сировини у барабан»  

(привод шнеку), 

• «уповільнення барабану у %»  

(привод сушильного барабану), 

• «витрата повітря через витяжку»  

(привод вентилятора), 

• «положення заслонки на трубопроводі подачі сировини у бункер», 

 

▪ виконавчі механізми: 

• «клапан»  

(в трубопроводі подачі сировини у бункер),  

• «шнек»  

(в трубопроводі подачі сировини в барабан), 

• «вентилятор» (у системі витяжки), 

• «конвеєр готової продукції»  

(на виході з барабану), 

• поворотна заслонка, 

 

▪ сигнальні лампи: 

• «перевищення дозволеного рівня сировини у бункері», 

• «відсутність сировини у бункері», 

• «ненормована вологість сировини на виході», 

• «допустима вологість сировини на виході» 

• «ненормована температура сировини на виході», 
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• «допустима температура сировини на виході», 

 

▪ додаткові об’єкти:  

• «щілинний переріз бункера сировини» (вертикальний, з анімацією 

рівня сировини у бункері),  

• «щілинний переріз барабану»  

(горизонтальний, без анімації рівня),  

• «датчик рівня сировини у бункері», 

• «анімація кількості сировини у на ділянках технологічного процесу» 

(4 ділянки по довжині барабану та 4 ділянки по довжині конвеєру), 

 

▪ інформаційні поля: 

• «вологість сировини на кінцевій 4-тій ділянці конвеєру на виході» + 

«температура сировини на 4-тій ділянці конвеєру на виході»  

(4 ділянки по довжині барабану та 4 ділянки по довжині конвеєру), 

• «надходження матеріалу на виході»  

(4-та кінцева ділянка конвеєра на виході технологічного процесу), 

 

o Екран 2 інтерфейсу з оператором містить: 

▪ кнопки:  

• «на екран технологічного  

процесу», 

▪ об’єкти:  

• вікно історії алармів; 

 

 

ПОРЯДОК ВИКОНАННЯ РОБОТИ 

 

1. Запустити PLC або його емулятор. 

2. Відкрити у середовищі розробки програм для PLC програму емулятор 

технологічного процесу. 

3. Встановити параметри з’єднання з PLC. Завантажити програму в PLC. 

Запусти виконання програми в PLC. 

4. У програмі конфігураторі OPC сервера обрати конфігурацію параметрів 

з’єднання між OPC та PLC через Gateway. 

5. Запустити середовище розробки SCADA систем. 

6. Забезпечити у програмі наявність каналів з’єднань з зовнішніми пристроями 

автоматики сконфігурувавши параметри з’єднання між SCADA та OPC. 

Отримати перелік змінних від PLC через OPC. 

7. Розробити візуальні форми з елементами відображення основних 

технологічних параметрів, полів вводу та елементів кнопкового управління, 

слайдерами неперервного задання параметрів та засобами інтерактивного 

відображення сповіщень відповідно до завдання. 



Житомирська 

політехніка 

МІНІСТЕРСТВО ОСВІТИ І НАУКИ УКРАЇНИ 

ДЕРЖАВНИЙ УНІВЕРСИТЕТ «ЖИТОМИРСЬКА ПОЛІТЕХНІКА» 

Система управління якістю відповідає ДСТУ ISO 9001:2015 

Ф-20.10-

05.02/2/174.00.1/М/ОК10-

1-2024 

Випуск 1 Зміни 0 Екземпляр № 1 Арк  58  / 37 

 

8. Підключити змінні, отримані від PLC, до інтерактивних елементів на формах 

візуалізації. 

9. Запустити програму та перевірити її працездатність. 

10. Зробити висновки про виконані завдання. У висновках дати відповіді на 

питання:  

- які можливості SCADA систем використано при розробці візуальних форм 

людино-машинної взаємодії; 

- які переваги створеної системи; 

- які можливі обмеження має використана технологія, 

- які можливо запропонувати удосконалення чи модифікації щодо виконаної 

розробки. 

 

 

ДОДАТКОВІ ЗАВДАННЯ 

 

1. Передбачити у SСADA системі блоки автоматичного управління 

технологічними параметрами, наприклад, систему автоматичного регулювання 

для стабілізації рівня сировини в баку з використанням PID або PI регулятора. 

2. Скоректувати математичну модель, що використовується в якості емулятора 

технологічного процесу, так, щоб математична модель містила елемент 

накопичення бракованої продукції та елемент накопичення продукції, що 

відповідає нормативам. 

3. Передбачити додаткову візуальну форму, що містить графіки параметрів 

технологічного процесу на його окремих ділянках, суміщені з панеллю 

управління основними виконавчими елементами, для підбору правильних 

параметрів налагодження по відстеженню поведінки графіків. 

 

 

ВІДОМОСТІ ЩОДО ВИКОНАННЯ 

 

 

Запуск системи програмування CoDeSys V2.3 

 

 Пуск-> Всі програми-> 3S Software-> CoDeSys V2.3 -> CoDeSysV2.3.exe 

 

Створення нового проекту 

 

Відкриваємо наданий викладачем файл process.pro проект-емулятор 

технологічного процесу з папки на робочому столі: industrial_process. Цільова 

платформа для цього проекту вже встановлена як емулятор CoDeSys сумісного 

контролера SP PLC Win NT V2.4. 
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Налагодження проекту програми PLC  

для використання поточним користувачем 

 

Виконаємо налагодження головних папок проекту. У головному меню 

CoDeSys: Project -> Options… -> Directories -> у секції Project -> у полях 

Libraries, Compile Files, Configuration Files за допомогою кнопки  

виставити шлях до папки створеного проекту. Типово папка на робочому столі 

користувача має шлях: 

  

    c:\users\user_name\desktop\project_01 

 

Цей шлях також ввести до поля Compile Files у секції General розділу 

Directories. 

 

 Оскільки відбулась зміна параметрів програми, бажано, про всяк випадок, 

здійснити перекомпіляцію програми. Для цього звернемося до головного меню 

CoDeSys та оберемо Project -> Clean All, далі, зайшовши ще раз до головного 

меню CoDeSys обираємо Project -> Rebuild All. Зберігаємося . 

Виконаємо перекомпіляцію проекту.   

 

З надією, що все вірно, спробуємо завантажити та запустити програму на 

контролері (або ж на сумісній системі виконання). 

 

Підготовка системи виконання  

– емулятора контролера та OPC серверу 

 

 - зазвичай це папка: 

 C:\Program Files\3S Software\CoDeSys SP PLCWinNT 

  - та папка: 

 C:\Program Files\3S Software\CoDeSysOPC 

 

 

Запуск системи виконання – емулятора контролера 

 

Налагодження каналу з’єднання з контролером 

Завантаження програми у контролер 

Запуск проекту 

 

 

Налагодження конфігурації OPC сервера 
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 З попередньо скопійованої на робочий стіл папки CoDeSysOPC 

запустити файл конфігуратор OPCConfig_e.exe. 

 Далі через головне меню програми File -> New -> клікнути правою 

кнопкою мишки на позицію – Server -> у випадаючому меню обрати команду 

Append PLC -> клікнути на позицію PLC1, що зявилась у дереві конфігурації, і 

у полі Project name ввести і’мя проекту process.pro -> клікнути на позицію 

Connection, що також з’явилась у дереві конфігурації -> клікнути на кнопку 

Edit, що відобразилась -> обрати з вже існуючих з’єднань, з’єднання, що 

обирали трохи раніше для зв’язку CoDeSys та PLCWinNT (!! у полі драйверу 

з’єднання має бути зазначений Tcp/Ip (Level 2 Route) ) -> підтверджуємо 

редагування цього рівня ОК. 

  Тепер знову звертаємося до головного меню File -> Save. Кінцево 

закриваємо вікно конфігуратора. 

 

Запуск OPC сервера 

 

Запуск програмного середовища Моvicon  

у режимі програмування (розробки) 

 

 Пуск-> Всі програми-> Movicon 11.2->  

  -> Movicon 11.2.exe 

 

Створення нового проекту 

 

Якщо середовище Movicon вже хоча б раз запускалося, то при відкритті буде 

відкрито попередній проект:  

 

 
 

Закриємо його: 

Клікнемо правою кнопкою мишки на кореневий елемент дерева проекту, як 

показано на рисунку, і у випадаючому меню оберемо команду Закрити. 

Тепер створення нового проекту потрібно розпочати командою Файл -> Новий 

(або інструментом  з панелі інструментів), одразу ж буде відкрито вікно 

майстра створення нового проекту, як на рисунку нижче. 

Якщо середовище Movicon запускається вперше то продовження запуску також 

супроводжується вікном майстра створення нового проекту: 
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 Далі оберемо тип платформу, на якій буде виконуватися створений 

проект: оберемо Win 32 (тобто для виконання на комп’ютері з 32 розрядною 

Windows, наприклад, промисловий комп’ютер з Windows CE 6.0, або на 

звичайному персональному комп’ютері). Вибір платформи впливає на перелік 

можливостей при подальшому наповненні проекту. Проте, обрану платформу 

завжди можна змінити у подальшому. 

  

 

Налагодження параметрів зв’язку 

проекту Movicon 

з OPC сервером CoDeSys  

 

 
 

 

Створення графічної частини проекту  

– форм візуалізації 

  

Обираємо в Експлорері Проекту пункт Екрани. Розкриємо його та подвійним 

кліком відкриємо візуальну форму екрану екран_процесу, який ми 

перейменували раніше. 
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Опис змінних з PLC, що будуть використані для керування  графічними 

елементами 

 

 

PLC2_PLC_PRG_start_row_material 

 - пуск потоку сирої сировини у трубопровід подачі сировини 

 

PLC2_PLC_PRG_raw_material_flow 

- значення потоку сирої сировини на вході технологічного процесу - у 

трубопроводі подачі сировини 

 

PLC2_PLC_PRG_valve_capacity 

- значення ступеню відкриття поворотної засувки для регулювання потоку 

сирої сировини у бункер 

 

PLC2_PLC_PRG_level_row_material 

- значення накопиченого рівня сировини у бункері 

 

PLC2_PLC_PRG_start_material 

- пуск шнекового живильника для дозованої подачі сировини з бункеру у 

сушильний барабан із заданою швидкістю 

 

PLC2_PLC_PRG_mat_flow 

 - значення швидкості подачі сировини шнековим живильником у 

сушильний барабан  

 

PLC2_PLC_PRG_material_dose 

 - доза матеріалу накопичувана у барабані від живильника за одиницю 

часу 

 

PLC2_PLC_PRG_start_drum 

- запуск обертання сушильного барабану із заданою швидкістю (чим більша 

швидкість обертання, тим більша швидкість перемішування сировини, а також 

швидкість просування часток сировини через барабан на його вихід) 

 

PLC2_PLC_PRG_cycle_duration 

- ступінь пригальмовування обертання сушильного барабану (при збільшенні 

збільшується кількість сировини у барабані) 
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 PLC2_PLC_PRG_start_air_flow 

- пуск втягування гарячого повітря (сушильного агенту в барабан) із заданою 

ступінню втягування (швидкістю обертання вентилятора) 

 

PLC2_PLC_PRG_hot_air_flow 

- значення швидкості обертання вентилятора втягування гарячого повітря через 

сушильний барабан 

 

PLC2_PLC_PRG_drum1_V_mat_out 

- кількість сировини, накопичена на першій ділянці сушильного барабану 

(всього 4 ділянки) 

 

PLC2_PLC_PRG_drum2_V_mat_out 

- кількість сировини, накопичена на другій ділянці сушильного барабану 

(всього 4 ділянки) 

 

PLC2_PLC_PRG_drum3_V_mat_out 

- кількість сировини, накопичена на третій ділянці сушильного барабану 

(всього 4 ділянки) 

 

PLC2_PLC_PRG_drum4_V_mat_out 

- кількість сировини, накопичена на четвертій ділянці сушильного барабану 

(всього 4 ділянки) 

 

PLC2_PLC_PRG_conveyor4_H_mat_out 

 - вологість сировини, накопичена на четвертій ділянці конвеєру (всього 4 

ділянки) – на виході технологічного процесу 

 

PLC2_PLC_PRG_conveyor4_T_mat_out 

- температура сировини, накопиченої на четвертій ділянці конвеєру (всього 4 

ділянки) – на виході технологічного процесу 

 

PLC2_PLC_PRG_conveyor4_V_mat_out 

- кількість сировини, накопиченої на четвертій ділянці конвеєру (всього 4 

ділянки) – на виході технологічного процесу 
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!! Звернути увагу:  у вказівках далі вказуватимуться змінні, що починаються 

на   PLC2_PLC_PRG_ ... . Цей початок може різнитися, у залежності від ПК на 

якому виконується проект. Наприклад, може бути так: PLC1_PLC_PRG_ .... 

Тому обережно використовуйте копіювання з тексту вказівок.  

 

Редагування статичних елементів 

візуальних форм 

 

Трубопровід подачі сировини у бункер 

 

 
 

Поворотна заслонка у  

трубопроводі подачі сировини 

 

  

 
 

 

Слайдер задання ступеню  

відкриття поворотної заслонки 

 

 
 

Кнопка запуску потоку сировини 
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Бункер  

накопичення сировини 

 

  

 
 

 

Щилина для відображення рівня  

у бункері накопичення сировини 

 

  

                      
 

Датчик рівня  

сировини у бункері 

 

  

                   
 

(довжину щупу можливо подовжити додавши видовжений прямокутник) 

 

 

Лампові сигналізатори максимального  

та мінімального рівнів у бункері 
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Трубопровід подачі сировини 

з бункера у барабан 

 

  

 
 

Шнек подачі сировини у барабан 

 

 

 
 

 

Двигун приводу шнеку 

 

 

 
 

 

Декоративний елемент  

- панель управління 

 

  
 

Слайдер управління інтенсивністю подачі 

шнекового живильника 
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Кнопка запуску в роботу 

шнекового живильника 

 

 

 
 

 Запустимо проект інструментом  на головній панелі інструментів 

середовища розробки Movicon. 

  

Призупинити режим RunTime можливо за допомогою інструмента  , а вийти 

з режиму RunTime – за допомогою інструмента  на панелі інструментів, що 

супроводжує режим RunTime: 

 

 
 

 

! Після виходу з режиму RunTime система автоматично відключає OPC сервер. 

Тому перед наступним запуском проекту необхідно спочатку запустити OPC 

сервер з папки, що на робочому столі. 

 

 

 Продовжимо графічне редагування візуальних форм. 

 

 

Сушильний барабан 
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Повітропровід подачі 

сушильного агенту до барабану 

 

 

 
 

 

Двигун приводу сушильного барабану 

 

 
 

 

Декоративний елемент  

- панель управління 
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Слайдер управління інтенсивністю гальмування 

обертання барабану 

 

 
 

 

Кнопка запуску в роботу 

сушильного барабану 

 

  
 

 

Вентилятор затягування  

гарячого повітря у сушильний барабан 
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Лабораторна робота №8 з програмування HMI в SCADA Movicon: 
SCADA ДЛЯ НЕПЕРЕРВНОГО ТЕХНОЛОГІЧНОГО ПРОЦЕСУ НА БАЗІ 

SCADA/HMI MOVICON ТА CODESYS-СУМІСНОГО PLC (Ч.2) 
 
 
ВІДОМОСТІ ЩОДО ВИКОНАННЯ 
 
 
Двигун приводу вентилятора 
 

 
 
  
Слайдер управління інтенсивністю 
обертання вентилятора 
 
  
 

 
 
 
Кнопка запуску в роботу 
вентилятора 
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Анімований вентилятор з лопастями 
 
 
 

     
 
 
Циклон на виході вентилятора 
 
 
  

 
 
 
Вихід сушильного барабану 
 
   

 
 
 
Конвеєр висушеної сировини 
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Позиція кінцевої ділянки конвеєра 
(пункт контролю параметрів  готової продукції) 
 
  

 
 
 

 
 
 

 
 
Лампові сигналізатори про знаходження  
параметрів температури та вологості 
висушеної сировини у дозволених межах 
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Візуальні елементи кількості 
матеріалу по довжині барабану та конвеєру 
 
 

 
 
 

 
 
  
  

 
 
 
 
Налагодження системи алармів  
(аварійних сповіщень) 
 
  

 
 
Тут можна додати додаткові колонки, що представлятимуть ті ж рядки, але на 
інших мовах. 
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Візуалізація активних алармів 
 
 

 
 
  
 Режим RunTime автоматично запуститься з відображенням сторінки 
екранної форми, що поточно редагувалась. Проте, якщо потрібно змінити 
сторінку, при відсутності кнопок переходу між сторінками (екранами), можна 

скористатися інструментом , що знаходиться на панелі інструментів режиму 
RunTime: 
 

 
 

 Відключити режим RunTime можливо кнопкою . 
 
 
Кнопки переключення  
між екранами 
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Закінчивши проект, тепер можемо нескінченно запускати його та перевіряти в 
дії.  
 
 
Демонстрація розроблених інтерактивних елементів сигналізації та 
управління 
 
Подайте у звіті такі зображення: 
 
- загальний вигляд форми візуалізації технологічного процесу (у запущеному 
стані) 
 
- загальний вигляд форми візуалізації з вікном алармів (у запущеному стані) 
 
- слайдер задавання ступеню відкриття заслонки та відповідне положення самої 
заслонки  у трубопроводі подачі сировини у бункер  
(активуйте попередньо кнопку запуску потоку сировини, покажіть положення 
повністю відкрито та будь-яке проміжне напіввідкрите положення заслонки) 
 
- вигляд бункеру накопичення сировини у режимі підвищення рівня сировини у 
бункері 
 
- досягти мінімального положення сировини у бункері, досягти максимального 
положення сировини у бункері, показати вигляд бункеру з ламповими 
сигналізаторами для цих станів рівня сировини 
(для досягнення таких станів маніпулювати параметрами технологічного 
процесу до та після бункеру за допомогою інтерактивних елементів візуалізації)  
 
- загальний вигляд трубопроводу подачі сировини з бункера у барабан зі шнеком, 
його приводом та елементами управління шнековим живильником у двох станах: 
відсутня подача та максимальна подача 
(для досягнення таких станів маніпулювати параметрами управління шнеком, 
або іншими елементами управління технологічним обладнанням до цієї ділянки)  
 
- три загальних вигляди сушильного барабану у трьох режимах його роботи: І – 
рівноміра завантаженість сировиною по всім ділянкам барабану, ІІ – основна 
завантаженість перших ділянок барабану, ІІІ – основна завантаженість на 
останніх ділянках 
(для досягнення таких станів маніпулювати елементами управління параметрами 
технологічного процесу до сушильного барабану та елементами управління 
самим сушильним барабаном) 
 
- три загальних вигляди вихідного конвеєра у трьох режимах його роботи: І – 
рівноміра завантаженість сировиною по всім ділянкам конвеєру, ІІ – основна 
завантаженість перших ділянок конвеєру, ІІІ – основна завантаженість на 
останніх ділянках 
(для досягнення таких станів маніпулювати елементами управління параметрами 
технологічного процесу до сушильного барабану та елементами управління 
самим сушильним барабаном) 
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- зображення полів контролю числових значень параметрів готової продукції та 
лампових сигналізаторів якості висушеної продукції при різних налагодженнях 
управляючих параметрів вентилятора та сушильного барабану 
 
 
4. Поясніть коротко технологічне призначення циклону на виході 
вентилятора 
 
5. Маніпулюючи елементами керування технологічним процесом 
урівноважити технологічний процес так, щоб вихідна продукція була у 
дозволених межах якості 
 
- відобразити у звіті загальний вигляд урівноваженого технологічного процесу і 
записати параметри управління окремими агрегатами, при яких вихідна 
продукція відповідає межам якості. 
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Глосарій 

 

№ з/п Термін державною мовою Відповідник англійською мовою 

1.  Людино-машинний інтерфейс HMI - human machine interface 

2.  
ПЛК - програмований логічний 

контролер 
PLC – programmable logic controller 

3.  Інтерфейс Interface 

4.  Промислова польова мережа Industrial field network 

5.  Шина Bus 

6.  Лінія сигналу Signal line 

7.  Давач, сенсор Sensor 

8.  Лінія входу Input/ Output line 

9.  Цифровий інтерфейс Digital interface 

10.  Напруга Voltage 

11.  Рівень сигналу Signal level 

12.  Дискретний вхід/вихід Discrete input/output 

13.  Аналоговий вхід/вихід Analog input/output 

14.  Користувач User 

15.  Оператор технологічної лінії Production line operator 

16.  Програма Program 

17.  
Організаційна одиниця при 

програмуванні 
POU – programming organization unit 

18.  Алгоритм Algorithm 

19.  Мова програмування Programming language 

20.  Релейно-контактна діаграма LD – ladder diagram 

21.  Діаграма функціональних блоків FBD – functional block diagram 

22.  Діаграма неперервного функціонування CFC – continuous function chart 

23.  Список інструкцій IL – instruction list  

24.  Структурований текст ST – structured text 

25.  Діаграма послідовного функціонування  SFC - Sequential Function Chart 

26.  Сигнал тривоги Alarm signal 

27.  Міжнародний Електротехнічний Комітет 
IEC (МЕК) - International Electrotechnical 

Committee 

28.  Динамічний обмін даними DDE – Dynamic Data Exchange 

29.  Технологія OLE для контролю процесів OPC – OLE  For  Process Control 

30.  Зв’язування та вбудовування об’єктів OLE – Object Linking and Embedding 

31.  
Розширювана (порівняно з HTML) мова 

розмітки 
XML – Extensible Mark-up Language 

32.  Віддалений кінцевий пристрій (термінал) RTU – Remote Terminal Unit 

33.  
Американський стандарт коду для обміну 

інформацією 

ASCII – American Standard Code for 

Information Interchange 

34.  Електро-магнітні перешкоди EMI – Electro Magnetic Interference 

35.  Світло-діод LED – light emitting diode 
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Рекомендована література 

 
 

 Основна література 

 
1. Добржанський О.О. Методичні вказівки для виконання лабораторних робіт з 

дисципліни «Засоби відображення інформації у системах автоматизації 

технологічних процесів» / О.О. Добржанський. – ДУЖП, 2024. – 150с., режим 

доступу: Лабораторні роботи 

2. CoDeSys V3.5 SP17 Features and Improvements, 2021. – 65с., available at: CoDeSys 

V3.5 SP17 Features and Improvements 

3. Movicon 11.3 Programmer Guide, 2019. – 764p., available at:  

Man_Eng_Mov11.3_Movicon_Programmer_Guide 

4. DELTA DOPSoft User Manual, 2021. – 2093p., available at: 

DELTA_DOPSoft_4.0_UM_EN_20211230 
 

 

 Допоміжна література 

 
5. Автоматизовані системи керування технологічними процесами. Метрологічне 

забезпечення: ДСТУ 2709-94. – [Чинний від 1995—07—01], режим доступу:  

DSTU_2709-94 

6. Пужна О.М. Промислові мережі та інтеграційні технології в автоматизованих 

системах. / О.М. Пужна, І.В. Ельперін, Н.П. Луцька, А.П. Ладанюк – К.: Ліра-К, 2015. 

– 552с., режим доступу: Промислові мережі та інтеграційні технології в автоматизованих 

системах | fieldbusbook 

7. CoDeSys V2.3 Programming, 2006. – 158с., available at: CoDeSys V2.3 manual 

8. CoDeSys Version 3.5 First Steps, 2014. – 74p., available at: CoDeSys-Version-3-5-First-

Steps 

9. CODESYS Beginners Tutorial, 2017. – 13p, available at: codesys V3.5-beginner-tutorial 

10. CoDeSys V2.3 Visualisation, 2006. – 84с., available at: CoDeSys_Visu_V23_E 

11. Siemens LOGO. Manual, 2009. – 280p., available at: logo_0BA6_system_manual 

12. LRD20T D024 Programmer Guide, 2009. – 123p, available at: LOVATO LRD 

Programming 

13. Touch Panel - 62H-MDC0, 2012. – 54p., available at: VIPA HMI  instructions 

HB160E_TP-ECO_62H-MDC0_12-09 

 

 

Інформаційні ресурси в Інтернеті 
 

 

1. Загальний каталог СВ АЛЬТЕРА 2023 р.  – Режим доступу:  Каталог СВ АЛЬТЕРА 2023 

2. Інтеграція засобів людино-машинного інтерфейсу в існуючі системи управління 

процесами. – Режим доступу:  Integrating an HMI Into Existing Control Systems - 

Technical Articles 

3. Що таке HMI? – Режим доступу:  What is HMI? Human Machine Interface 

4. Людино-машинний інтерфейс: типи, інструменти та майбутні тренди – Режим доступу: 

Human Machine Interface (HMI): Types, Tools & Future Trends 

https://drive.google.com/drive/folders/10KL6RmeFe3cTDi-feUYnFBidiHVWVWCm?usp=sharing
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/CoDeSys-V35SP17-features-and-improvements-en.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/CoDeSys-V35SP17-features-and-improvements-en.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/Mov11.3_Movicon_Programmer_Guide.pdf?forcedownload=1
https://filecenter.deltaww.com/Products/download/06/060302/Manual/DELTA_IA-HMI_DOPSoft_UM_EN_20211230.pdf
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/DSTU_2709-94.docx?forcedownload=1
https://pupenasan.github.io/fieldbusbook/2010/
https://pupenasan.github.io/fieldbusbook/2010/
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/CoDeSys%20V2.3%20manual.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/CoDeSys-Version-3-5-First-Steps-Ver-1.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/CoDeSys-Version-3-5-First-Steps-Ver-1.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/codesys%20V3.5-beginner-tutorial.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/CoDeSys_Visu_V23_E.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/logo_0BA6_system_manual_en.pdf?forcedownload=1https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/logo_0BA6_system_manual_en.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/LOVATO%20LRD%20Programming.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/LOVATO%20LRD%20Programming.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/VIPA%20HMI%20%20instructions%20HB160E_TP-ECO_62H-MDC0_12-09.pdf?forcedownload=1
https://learn.ztu.edu.ua/pluginfile.php/395511/mod_folder/content/0/VIPA%20HMI%20%20instructions%20HB160E_TP-ECO_62H-MDC0_12-09.pdf?forcedownload=1
https://www.svaltera.ua/upload/iblock/426/wbb4rnmo9s7e44s6juk83dno8hhvjlhu/sva_cat_full_ukr_web.pdf
https://control.com/technical-articles/integrating-an-hmi-into-existing-control-systems/?form=MG0AV3
https://control.com/technical-articles/integrating-an-hmi-into-existing-control-systems/?form=MG0AV3
https://inductiveautomation.com/resources/article/what-is-hmi?form=MG0AV3
https://www.indmall.in/hub/human-machine-interface/?form=MG0AV3
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5. Програмовані HMI. – Режим доступу:   Programmable HMIs | Hans TURCK GmbH Co. 

KG 

6. Сенсорні HMI панелі DELTA. – Режим доступу: Products - Touch Panel HMI - Human 

Machine Interfaces - Delta 

7. Програмований логічний контролер. – Режим доступу: Програмований логічний 

контролер — Вікіпедія 

https://www.turck.de/en/productgroup/Industrial%20Controls/Programmable%20HMIs;jsessionid=7F26871DE279744B22AD0CC36AE0A150
https://www.turck.de/en/productgroup/Industrial%20Controls/Programmable%20HMIs;jsessionid=7F26871DE279744B22AD0CC36AE0A150
https://www.deltaww.com/en-US/products/Touch-Panel-HMI-Human-Machine-Interfaces/ALL/
https://www.deltaww.com/en-US/products/Touch-Panel-HMI-Human-Machine-Interfaces/ALL/
https://uk.wikipedia.org/wiki/%D0%9F%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%BE%D0%B2%D0%B0%D0%BD%D0%B8%D0%B9_%D0%BB%D0%BE%D0%B3%D1%96%D1%87%D0%BD%D0%B8%D0%B9_%D0%BA%D0%BE%D0%BD%D1%82%D1%80%D0%BE%D0%BB%D0%B5%D1%80
https://uk.wikipedia.org/wiki/%D0%9F%D1%80%D0%BE%D0%B3%D1%80%D0%B0%D0%BC%D0%BE%D0%B2%D0%B0%D0%BD%D0%B8%D0%B9_%D0%BB%D0%BE%D0%B3%D1%96%D1%87%D0%BD%D0%B8%D0%B9_%D0%BA%D0%BE%D0%BD%D1%82%D1%80%D0%BE%D0%BB%D0%B5%D1%80

